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Pre Installation Tasks
Saving Existing Reports, Macros, Searches, etc.

The Remedy Home directory location has changed with the new client to comply with Microsoft standards. This Home directory holds your customized reports, macros, Saved searches and preferences. You will need to save these items when you upgrade to the new version of the User client

The default location of the Remedy Home directory for the previous version of the Desktop Client is C:\Program Files\AR System\Home.
To verify the location of your current Remedy Home directory, log on to the Remedy Desktop Client and from the menu bar select: Tools >>>Account
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Press the Users button in the lower left hand corner of the dialog to find your home directory
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Note: The Home directory contents in the Remedy Desktop Client are identifiable by the file extensions and locations listed below.

Category


 Location

Executables


<ar_home_dir>\*.exe

User configuration 

<ar_home_dir>\ar.ini

Macros 



<ar_home_dir>\arcmds\<macro_name>.arq

User defaults 


<ar_home_dir>\<form_name>.ard

User views 


<ar_home_dir>\<form_name>.arv

Form definition cache

 <ar_home_dir>\<form_name>.arf

Custom report design 

<ar_home_dir>\arcmds\<report_name>.arr

You will need to copy the entire Home directory (including all files and sub directories) to your Desktop prior to starting the installation. After you complete the Remedy Desktop Client 6.03 installation, move the Home directory to the default Home directory location at C:\Documents and Settings\XXXXXXX\Application Data\AR System, where XXXXXXX is the login name you use when starting your desktop system.
NOTE: If you do not see an Application Data folder do the following to make it visible:  Using Windows Explorer you will select Tools>>>Folder Options.  Click the “View” tab and change the setting under Hidden Files and Folders to “Show hidden files and folders”.  Then select Apply to All Folders and click Ok.

Uninstall Existing Version

Before you perform an installation of Remedy Desktop Client 6.03, verify your account has the necessary permissions to uninstall the current Remedy Desktop Client and install the new version. 

Verify that your account has Administrator rights on the workstation, by selecting
Start>>>Control Panel>>>User Accounts  
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
Verify that you login account has “Administrators” in the Group setting. This means that you have Administrative privileges on the workstation and will be able to complete the installation processes. 

NOTE: If “Administrators” is not listed in the Group Setting, STOP! Contact your local Desktop Support to grant your login account “Administrative” permissions or to conduct the actual installation.

Close all applications and navigate to the “Add or Remove Programs” by selecting Start >> Settings >> Control Panel >>Add Or Remove Programs >> ARSystem 5.1
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Press the Remove button to begin the process of uninstalling the current version.
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Press the Yes button to confirm that you are removing “AR System User 5.1” and all of its components.
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Press the Yes button to confirm deleting the files in the installation directory.
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Press the Yes button to confirm the removal of the files in the Remedy Home directory. 

NOTE: If you remove the files and have not copied them in a separate directory as described in the Pre-installation tasks you will lose all of your saved Remedy information (Preferences, Searches, Macros, etc…). Please select No if you still wish to retain these files and follow the directions in the Pre-installation tasks.
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During the removal of the Remedy Client, you may be prompted with the “Remove Shared File?” Dialogue. If this dialogue is presented, press the Yes to All button.

[image: image9.png]Remove Shared File?

? ) Youhave chosen to rerove al shared components which the system ndicates are o onger being used. This may

<3/ causo some progras ik o fnchion F they Slretire any f thes Hes. Aveyou st you wark o proceed?

Ves o





You will be prompted to confirm your selection. Press the Yes button to continue.
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Press the OK button when the removal process is complete.

Once the system returns you to the “Add or Remove Programs” window, verify that the AR System User 5.1 entry no longer exists. After you have verified the application is no longer in the list, you will need to close the “Add or Remove Programs” window and reboot your system. 

NOTE: You must reboot your system at this point. Failure to reboot your system will result in problems installing the new version. 

Remedy Desktop Client 6.03 Installation
Download the installation software at the following site: http://isdp.nih.gov/downloads/utilities.asp. The installation file is located at the bottom of the page under the “Remedy Client” section. The hyperlink is listed as Remedy Client. After you select the hyperlink, it will ask you to open or save the file. Save the file to your workstation. After the file has saved, go to and run the downloaded file user.exe.
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The welcome screen appears

[image: image12.png]Remedy User 6.3 ] ﬁ

as63 ARSusertUninst... hsb-wireportXls SWCDSQLSw  Shortaut to NED Notes.doc:

fBRemedy - s “a o & 3

oSN Sftvre compary st My Network N CistomErer ReportServer WRLA025mp il Desk
S Reaatoft
: - - = o mn R
o —
ARS 5.1.2install isg on HSB-WIN.rpt ~ SystemUpdates.... Google Earth Help Desk
‘petridcssupp... Survey.oft
] = o0 @ - ® A
E— = o
e cepedsaSon'CIT CITSevice ket ARSG.3Fom  WebExPayer FLA GIOTP.fles  Rem ol User
Server (petri) (H) for HSB-Win S... modifications.doc Guide - Versi..
- B O o)
devs et Shortatto  HSBWNexcelmpt devhsog  Stored
e i Py

ools  CIT Service et preferences.am _remedy
for HSB-in .. permissions ...

-'“1:3%

Software _Remedy User  utl_UPDATERE... _~gmedy User

This program s prl
intemalional raties

Tool 6.3 migrat.. Tool 6.3 migrat..
New Microsoft Change requests  upmssdl.Zp. ~MRL2797.tmp  ARS 6.3 Upgrade uti_OUTLOOK... NIH Custom Error ~WRLIS1S.tmp
Word Doau.... messages.csv.
. ensa 2000a.. MNotepad++ ~VIRL24Z5.tmp

Recyde Bin





Click Next to proceed to the Software License Agreement screen.
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Click I Agree to accept the licensing terms

The Select Components screen appears you will accept the default for this installation. Click Next
 to continue
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The Select Action Request User Resource screen appears
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 Select the language or languages for this installation. English is the default language selected.

 Click Next to continue.
The Choose Destination Folders screen appears
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You will accept the defaults for this section. Click Next to continue with the installation.
The AR System Server Locations screen appears.

[image: image17.png]Remedy User 6.3

Remedy

figur

This liss

Remedy

Action
Request
System

© 1599 - 2005
Remady, >

BINC Sohuwars company.
Al ighs Resared

L e ————

Ele Edt Vew Insert Fomet Tods Teble Window

NEERSERYE L RBI I -0 REDRES ST
Showing Merkup vrmw-\y)@)gvg.\gsty.\mg!
Normal +Minos - MronRegular  ~ 11 +| B Z U |[E]

9 Click Next.
The Choose Destination Folders screen appears

Remedy User 6.3

10 Click Next
The AR System Server Locations screen appears

11 Tthe AR System servers configared in the previous installation will be listed.
At least one AR System server must be available fo use Remedy User. After
installation, you can add, modify, and remove servers when you log in to
Remedy User

n14 Col 1

Recyde B W CDSQL Swr
Standard Edin




The AR System servers configured in the previous installation should be listed. 
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If no servers are listed, click on the Add button. Enter the server name “rx.nih.gov” in the field and leave the remaining fields blank. Click OK to add the server to the list. Click Next to continue
The Summary screen appears
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Click Next to begin the installation.
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NOTE: There have been some reports of the installation hanging during this process. Specifically the installation will hang with a “Windows Installer” dialogue showing. If this occurs you will need to go into the Task Manager (Ctrl-Alt-Del and select Task Manager button) and end the Windows Installer application. 

You should not end the” Remedy Installer” application, as this may cause problems when using the application. 
After ending the “Windows Installer” application, another one will appear. You will need to repeat the process four additional times to get to the Setup Complete screen.

When the installation is complete, the Setup Complete screen appears
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Click Finish to complete the installation

Post Installation Notes
After the installation is complete, you will need to copy the “Home” directory to the new location as described in the first section of this document (See Page 3 for Details). If you do not do this you will not have access to your saved information.

You will also need to Verify that the “Search Path” in the “General” tab contains only C:\Documents and Settings\XXXXXXX\Application Data\AR System, where XXXXXXX is the login name you use when starting your desktop system.. This is done by opening the Remedy Desktop Client and selecting Tools >>> Options from the drop down menus.
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Verify that the “Search Path” in the “General” tab contains only C:\Documents and Settings\XXXXXXX\Application Data\AR System, where XXXXXXX is the login name you use when starting your desktop system.  Modify the path to make sure this is correct and press the OK button. You will need to close the Remedy Desktop Client, then restart the Remedy Desktop Client.

You will also need to reset your report server information for the application. This is done by opening the Remedy Desktop Client and selecting Tools >>> Options from the drop down menus.
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Select the “Advanced” tab in the resulting window.
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Enter the “rx.nih.gov” server name in the Report Server field in the Reports section of the tab. Make sure the “ODBC Use Underscores” box is checked. Press the OK button to return to the main screen.

Optional Instructions for Removing/Adding Home Page

If you are not already in the Remedy Desktop Client, start the Remedy Desktop Client and log into the application using your credentials.
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Once the application has loaded, select Tools>>> Options from the drop down menu bar at the top of the window. The Options Window will appear.
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Select the Home Page tab in the Options window. The “Open Home Page Automatically” is selected by default.
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You have the option to have your Home Page load automatically, or not, when the Remedy Client starts. Uncheck the “Open Home Page Automatically” to stop the system from loading the home page when you enter the Remedy User Tool or check the box to have the Home Page load when you enter the Remedy User Tool. When finished click the OK button to save your configuration.
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Select “Tools -> Login” from the drop down menu bar at the top of the window. You will be prompted with the Remedy Login screen. Log into remedy using your credentials to verify that the Home page does or does not display on login, depending on the option you selected.
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Important Daylight Savings Time Patching Information








Because of a provision in the Federal Energy Policy Act of 2005, Daylight Saving Time (DST) is coming early and ending late in 2007. DST will start on Sunday March 11, 2007 and end on Sunday November 4, 2007.





Remedy clients prior to version 6.03 patch 20 will record and display incorrect timestamps as of March 11, therefore it is imperative that all users upgrade their client prior to this date.





Remedy Client version 6.03 patch 20 was posted to the iSDP as of 3:00 PM on 2/21/2007. This is the patch needed to ensure the continued integrity of the Remedy system. 





If you have previously installed an earlier version of the 6.03 client provided by CIT and you followed the earlier version of these instructions, your upgrade will be simple and you may skip directly to the section labeled “Remedy Desktop Client 6.03 Installation”. No other steps are necessary, just the instructions in this one section. Pre-installation, removal of previous versions, and post-installation may all be bypassed.





If you are upgrading from version 5.x of the client (or any other prior versions) you will need to follow the full instructions as outlined herein.





If you are unsure of your current Remedy client patch level, open the client and select “About Remedy User” from the “Help” menu. The version and patch level will appear on the lower left side of the “About” display. If you are still unsure as to your appropriate steps, you should submit a ticket to the NIH Help Desk by going to � HYPERLINK "http://ithelpdesk.nih.gov" ��http://ithelpdesk.nih.gov� and clicking on “Submit Service Request” in the upper left corner. Your ticket will be sent to your local desktop support.





In order to ensure the continued operations of the CIT Remedy system and to protect the integrity of the data housed therein, earlier versions of the client will be prohibited from logging onto the system as of March 11, 2007.





Link to download current supported version of Remedy client:


� HYPERLINK "http://isdp.nih.gov/downloads/utilities.asp" \l "remedy" \o "http://isdp.nih.gov/downloads/utilities.asp#remedy" �http://isdp.nih.gov/downloads/utilities.asp#remedy�





Sysadmins and Desktop Support Technicians please note that the only substantive change in these instructions from the previous version is the inclusion of this section on DST information. All other instructions in this document are unchanged from previous versions.
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